Let's start C Controller!

Q24DHCCPU-V

Smart & Easy

A simpler and more sophisticated integrated-system platform is now available with the C Controller.
The following table lists symbols used in this guide with descriptions and examples.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Point" /></td>
<td>Shows information you need to know.</td>
<td>The C Controller module executes program operation regardless of the switch status (RUN/STOP).</td>
</tr>
<tr>
<td><img src="image" alt="Reference" /></td>
<td>Shows reference manuals and pages on which you can find the details.</td>
<td>Refer to the following. MELSEC-Q C Controller Module User's Manual: SH-081130ENG</td>
</tr>
<tr>
<td><img src="image" alt="Terminology" /></td>
<td>Shows the explanations of terminology.</td>
<td>Buffer memory: The memory of an intelligent function module used to store data (such as setting values and monitored values) for communication with a C Controller module</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>Shows descriptions that must be noted.</td>
<td>Power off the system before mounting a module.</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Menu names on the menu bar ([ ]→[ ] shows drop-down menus.)</td>
<td>Select [Project]→[New].</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Buttons on the window</td>
<td>Button</td>
</tr>
<tr>
<td><img src="image" alt=" " /></td>
<td>Keys on the keyboard</td>
<td>F4 key</td>
</tr>
</tbody>
</table>
This guide simply explains the basic operations of a C Controller module for the first-time users of the Mitsubishi programmable controller MELSEC-Q series C Controller module Q24DHCCPU-V (hereafter abbreviated as C Controller module).

This guide is targeted for users who use the MELSEC-Q series for the first time and are in the following situations:

• Users with experience in C language or C++ language programming
• Users considering to replace the microcomputer board or the personal computer system with a C Controller system

**Reference**

- Precautions
  For safe use of the C Controller module, read "SAFETY PRECAUTIONS" in the C Controller Module User's Manual.

**Caution**

This guide explains operations using the system configuration in "<2> System Configuration" (P.15).

When designing/operating a system, refer to the manuals listed in the following.

"RELATED MANUALS" (P.12)
CONTENTS

1 HOW TO READ THIS GUIDE ................................. 1

2 INTRODUCTION ........................................... 2

3 OPERATIONS THAT CAN BE PERFORMED USING C CONTROLLER MODULE ........................................ 5
   ■ Sophisticated and high-speed processes and communications with the higher server .............. 5
   ■ Stable information processing ability and high real time property ........................................... 6
   ■ Features ...................................................................................................................................... 7

4 RELATED MANUALS ........................................ 12
   ■ Learning about a C Controller module ....................................................................................... 12
   ■ Learning about CW Workbench ................................................................................................ 12

5 USING C CONTROLLER MODULE ......................... 13
   <1> Preparing for Operation ........................................................................................................ 14
   <2> System Configuration ........................................................................................................... 15
       1) System configuration example .......................................................................................... 15
       2) Mounting the modules ....................................................................................................... 16
       3) Wiring the modules ........................................................................................................... 17
       4) Checking the power supply module .................................................................................. 19
   <3> Setting the Module .................................................................................................................. 20
       1) Initializing the C Controller module ................................................................................... 20
       2) Setting parameters ............................................................................................................ 22
   <4> Knowledge Required for Programming ................................................................................. 26
       1) Dedicated Function Library ............................................................................................... 26
       2) Dedicated functions used in this guide ............................................................................. 27
   <5> Programming ........................................................................................................................ 29
       1) Creating a project .............................................................................................................. 32
       2) Creating a user program .................................................................................................... 36
       3) Generating an execution module from the user program ................................................. 37
       4) Connecting a C Controller module to CW Workbench ...................................................... 38
       5) Debugging the user program ............................................................................................ 40
       6) Registering an execution module ...................................................................................... 44
   <6> Checking Operations ............................................................................................................... 46

6 FREQUENTLY-USED FUNCTIONS ......................... 49
   <1> Checking Errors ..................................................................................................................... 49
       1) How to check an error ........................................................................................................ 49
       2) Checking error history ....................................................................................................... 50
   <2> Monitoring Module Status and Testing Operations .................................................................. 51
       1) Checking module I/O status and buffer memory status .................................................. 51
       2) Testing operations by forced output .................................................................................. 53
A C Controller module is a CPU module that supervises MELSEC-Q series modules and controls I/O devices using C language or C++ language program, and is used for the following:

- Reuse a C language or C++ language program developed under a microcomputer board and personal computer environment.
- Perform sophisticated and high-speed operation process, which is hard for ladder programs to handle, required in the fields such as manufacturing of semiconductor products and solar cells; and remote monitoring of public infrastructures (e.g. electricity, gas, and water systems).

The C Controller module easily achieves various functions using user programs. Combined with partner products, the module can also perform the following functions.

- Program-free SECS communication commonly used for semiconductor manufacturing and direct communication with the higher server without a gateway personal computer can be executed through a SECS communication software package.
- In collaboration with a vision system, image distinction and product inspection can be performed without a personal computer.
Stable information processing ability and high real time property

1. Suppressing variations in user program execution for stable information processings

A C Controller module is equipped with two types of MPUs: an MPU for system control and an MPU for user program execution.

For this reason, a user program can be executed independently from the system control, and variations caused by a load state of the system control when a user program is executed can be minimized.

2. Various functions for real-time control

The C Controller module equips VxWorks (Wind River Systems, Inc.), real-time OS with many achievements and high reliability (The runtime license does not cost).

Since VxWorks supports a preemptive system*1, allowing real-time operation and sophisticated process that require an interrupt and punctuality, which may not be ensured under personal computer environment.

VxWorks also equips various functions, such as file access, drivers for the network functions, I/O and communication libraries, and therefore can be used for various purposes.

*1 A system that equally assigns execution time to multiple programs so that the processor (CPU) may not be dedicated to one program
Features

I. Flexible system configuration using various MELSEC-Q series modules

In a C Controller system, program resources can be reused and various MELSEC-Q series modules are available, making system configuration easier.
2. Equipped OS, drivers, and libraries allow you to focus on developing user programs
Since OS and communication drivers have been equipped with a C Controller module, you are no longer bothered with troublesome work under microcomputer board and personal computer environment (OS porting, driver development, OS writing to ROM) and can focus on developing a user program.

The C Controller module can easily access MELSEC-Q series modules using library functions dedicated for a C Controller module (bus interface function, MELSEC communication function).
3. Initialization, parameter settings, monitoring, and testing can be executed without a program

Complex programs for the initialization and the system settings of a C Controller module, and parameter settings of a network module are not required. The operations can be easily executed on view-friendly Setting/monitoring tool for C Controller module.

Programs to check module status, errors occurred in a C Controller module and in a user program, cable disconnection, and communication status are also not required.
4. Quick start using an integrated development environment, "CW Workbench"
An engineering tool for C Controller, "CW Workbench", equips basic functions such as program editing, generation of execution module, and debugging. A user program for a C Controller module is easily developed.
Eclipse-based CW Workbench allows function enhancement using a third-party plug-in software.

The plug-in feature allows multilingualization of menu items and source code management.
5. **Wide application using partner products**

In combination with the following partner products, higher functionality and easy information link can be achieved.

(1) **Collaboration with the vision system (COGNEX In-Sight EZ and In-Sight7000 series)**

Collaboration of the COGNEX machine vision with the C Controller module can easily automate manufacturing processes including measurement, inspection, and distinction of products.

---

**Reference**

For the detail of 3rd Party partner product, refer to the following.

- iQ Platform C Controller: L(NA)08165E
RELATED MANUALS

This guide explains the basic operations of a C Controller module.
To make maximum use of the C Controller module, refer to the following.

■ Learning about a C Controller module

  SH-081130ENG
  This manual explains the system configuration, specifications, functions, handling, wiring troubleshooting, and programming and function of a C Controller module.

- Setting/Monitoring Tools for the C Controller Module Operating Manual
  SH-081131ENG
  This manual explains the system configuration and operation method of Setting/monitoring tools for the C Controller module.

■ Learning about CW Workbench

- CW Workbench Operating Manual
  SH-080982ENG
  This manual explains the system configuration, installation and uninstallation, specifications, functions, and troubleshooting of CW Workbench.
USING C CONTROLLER MODULE

The C Controller module is installed with procedures as shown below.

<1> Preparing for Operation (P.14)
Preparing the necessary devices

<2> System Configuration (P.15)
Installing, wiring, and powering on the devices
1) System configuration example (P.15)
   Showing the example of system configuration used in this guide
2) Mounting the modules (P.16)
   Mounting the prepared modules on a base unit
3) Wiring the modules (P.17)
   Wiring the power supply module and the output module
4) Checking the power supply module (P.19)
   Powering on the system and checking module status

<3> Setting the Module (P.20)
Configuring settings to operate the C Controller module using
Setting/monitoring tools for the C Controller module.
1) Initializing the C Controller module (P.20)
   Preparing a standard RAM
2) Setting parameters (P.22)
   Setting parameters for the C Controller module

<4> Knowledge Required for Programming (P.26)
Explaining the bus interface function
1) Dedicated Function Library (P.26)
2) Dedicated functions used in this guide (P.27)

<5> Programming (P.29)
Creating a program using CW Workbench
1) Creating a project (P.32)
   Starting CW Workbench, creating projects, and configure settings
2) Creating a user program (P.36)
   Creating a user program that controls a C Controller system.
3) Generating an execution module from the user program (P.37)
   Converting (Building) the created program into an executable module
4) Connecting a C Controller module to CW Workbench (P.38)
   Connecting a C Controller module to CW Workbench to perform debugging
5) Debugging the user program (P.40)
   Checking operations of the created program
6) Registering an execution module (P.44)
   Building the created program for operation and storing the program on the C
   Controller module

<6> Checking Operations (P.46)
Executing the program and checking operations
1) Prepare the necessary devices.

- **C Controller system**
- **Personal computer**
- **Setting/monitoring tools for the C Controller module (SW4PVC-CCPU)**
- **CW Workbench**
- **Ethernet cable**

*1 Install Setting/monitoring tools for the C Controller module (SW4PVC-CCPU) and CW Workbench on the same personal computer beforehand.

**Reference**

For installation of Setting/monitoring tools for the C Controller module, refer to the following.

- Setting/Monitoring Tools for the C Controller Module Operating Manual: SH-081131ENG

For installation of CW Workbench, refer to the following.

- CW Workbench Operating Manual: SH-080982ENG
<2> System Configuration

1) System configuration example

This guide uses the following system configuration as an example.

* A wire to the power supply module is omitted.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Model</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Base unit</td>
<td>Q33B</td>
<td>A unit on which a power supply module, a C Controller module, and I/O modules are mounted</td>
</tr>
<tr>
<td>2)</td>
<td>Power supply module</td>
<td>Q62P</td>
<td>Supplies power to modules such as a C Controller module and I/O modules.</td>
</tr>
<tr>
<td>3)</td>
<td>C Controller module</td>
<td>Q24DHCCPU-V</td>
<td>Supervises the control process of a C Controller system.</td>
</tr>
<tr>
<td>4)</td>
<td>Output module</td>
<td>QY40P</td>
<td>Connects with output devices. Lamps are connected in this example.</td>
</tr>
<tr>
<td>5)</td>
<td>Cable (Ethernet cable)</td>
<td></td>
<td>Connects the personal computer with Setting/monitoring tools for the C Controller module and the C Controller module.</td>
</tr>
<tr>
<td>6)</td>
<td>Cable (Ethernet cable)</td>
<td></td>
<td>Connects the personal computer with CW Workbench and the C Controller module.</td>
</tr>
</tbody>
</table>
2) Mounting the modules

Mount the prepared modules on a base unit.

When using the C Controller module for the first time, connect a battery connector.

**Caution**

- Mount a battery before operation.
- Power off the system before mounting a module.

**Point**

- Mounting a battery to the C Controller module

  1. Open the C controller module bottom cover.
  2. Check the battery is correctly installed.
  3. Connect the battery connector to the connector pin on the case, checking the orientation.
  4. Seat the excess lead wire on the top of the battery.
  5. Securely insert the module fixing projection*¹ into the module fixing hole so that the latch is not misaligned.
  6. Using the module fixing hole as a supporting point, push the module in the direction of arrow until it clicks.
  7. Make sure that the module is inserted in the base unit securely.

**Reference**

For how to remove a module, refer to the following.

3) Wiring the modules

Wire the power supply module.

**Caution**

Power off the system before wiring the module.

**Reference**

For wiring precautions, refer to the following.

QCPU User's Manual (Hardware Design, Maintenance and Inspection): SH-080483ENG

1. Wiring the power supply module

The following shows an example of wiring the power wire and the ground wire to the base unit.

Provide grounding to prevent electric shock and malfunction.

1) Connect a 100VAC-power supply to the power input terminal.

2) Ground LG and FG terminals.
2. Wiring the output module

The following shows an example of wiring the output module (QY40P).

Wire the power supply line of the output device and that of the C Controller system separately as shown below.
4) Checking the power supply module

Check that the power supply module runs normally after installing the system, mounting the modules, and wiring the system.

Operating procedure

1. Check the following before powering on the system.
   • Wiring to the power supply module
   • Power supply voltage

2. Set the C Controller module to STOP.

   Open the cover on the front of the C Controller module and set the "RUN/STOP/MODE" switch to "STOP".

3. Power on the power supply module.

4. Check that the power supply module runs normally.

Check the front LED on each module.
The following lists the normal status of the LEDs.
1) Power supply module: The "POWER" LED lights in green.
2) C Controller module: The "MODE" LED lights in green.
3) C Controller module: The "U RDY" LED lights after flashing in green.
   Then, initialize the module.
   "<3> Setting the Module" (P.20)

Construction of the system is ended.

Point

If the "POWER" LED of the power supply module remains off even after power-on, check that the power supply module is correctly wired and mounted.

Reference

If the "ERR." LED turns on or starts flashing, troubleshoot with reference to the following.

<3> Setting the Module

Configure settings to operate the C Controller module.

1) Initializing the C Controller module

Initialization deletes data in the C Controller module.
Before you can perform the initialization, back up all necessary data, user programs and parameters.

Operating procedure:

1) Open the cover on the module front and set the "RESET/SELECT" switch to "RESET".

![Image of reset/selection switch]

2) Check that the LED is off.

![Image of LED off]

3) Holding the "RUN/STOP/MODE" switch on the "MODE" position, set the "RESET/SELECT" switch to the center.

![Image of switch to center]

4) Check that the "MODE" LED lights in "orange", and the dot matrix LED displays "M-00".

![Image of "M-00" display]

5) Release the "RUN/STOP/MODE" switch. The switch returns to the "STOP" position.

![Image of switch return to stop]

6) Repeatedly set the "RESET/SELECT" switch to "SELECT" until the dot matrix LED displays "0011" ("module initialization setting" mode).

![Image of switch to "SELECT" mode]

7) Set the "RUN/STOP/MODE" switch to "RUN" and initialize the module. The "RUN" LED will be flashing during initialization.

![Image of "RUN" LED flashing]
8) Check that the "RUN" LED turns off, and the dot matrix LED displays "0000". Reset the C Controller module.

9) Resetting the C Controller module will initialize the module. The "RUN" LED and the "USER" LED start flashing in green.

10) When the initialization is completed, the "RUN" LED and the "USER" LED end flashing, and the "MODE" LED starts flashing in green.

11) Reset the C Controller module. When the initialization is completed, the "RUN" LED, the "MODE" LED, and "U RDY" LED light in green.

Resetting procedure

1) Set the "RESET/SELECT" switch on the front of the C Controller module to "RESET".

2) Check that the "MODE" LED turns off.

[Reset end status]

3) Set the "RESET/SELECT" switch to the center.

Caution

Do not operate the switches using a sharp-pointed tool such as a driver. Doing so may damage the switches.
2) Setting parameters

Set parameters for the C Controller module.

**Terminology**

Parameter: Setting data required for a C Controller system to operate.

Set modules and a network in a C Controller system using Setting/monitoring tools for the C Controller module.

I. Connecting a C Controller module to a personal computer

Connect the system Ethernet port(S CH1) of the C Controller module to a personal computer using an Ethernet cable.

**Caution**

The IP address of the C Controller module and that of the personal computer must be set to the same segment.

Since this guide uses the default IP address for the C Controller module's system Ethernet port(S CH1) (192.168.3.39), set the IP address for the personal computer to "192.168.3.* (*: other than 0, 3, 39, and 255)".

Set the subnet mask for the personal computer to "255.255.255.0".

**Reference**

For how to change an IP address, refer to the following.

2. Create a parameter on the personal computer

**Operating procedure**

1) Start up the Setting/monitoring tools for the C Controller module.
   
   Select [Start]→[All Programs]→[MELSEC]→[C Controller module Ver.4]→[Setting/monitoring tools for the C Controller module].

2) Create a project.
   
   [Project]→[New].

   ![New Project dialog](image)

   For Setting/monitoring tools for the C Controller module Version 4.02C or later, select "Q24DHC-V" for the CPU type.

3) Set the CCPU Parameter.
   
   Project view →"Parameter"→"CCPU Parameter"→"I/O assignment settings".

![CCPU parameter setting](image)

**Reference**

For each setting screen and setting item, refer to the following.

- Setting/Monitoring Tools for the C Controller Module Operating Manual
  
  : SH-081131ENG
3. Writing the parameters to the C Controller module

1) Set the C Controller module for the connection destination.

   Select Navigation window → Connection Destination view → "(connection destination data name)".

2) Write the parameters.

   [Online] → [Write to CCPU]

   Click [Select All] button → Click [Execute] button
4. Reset the C Controller system.
   The written parameters are applied.

Point

When the account input screen appears, enter the following:
User name: target
Password: password
1) Dedicated Function Library

The dedicated function library is a function implemented in a C Controller module as standard. The following functions are available for controlling each module and reading the operating status.

- **Bus interface functions**
  This function controls I/O modules and intelligent function modules via a bus of a base unit.

- **C Controller Module Dedicated Function**
  This function controls the operating status and the indicator LED of a C Controller module.

### I. Bus interface functions

1. **Opening/closing a bus**

   To use the functions, open a bus at the start of the program and close the bus at the end of the program.

   Functions to open/close a bus

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>QBF_Open</td>
<td>Opens a bus.</td>
</tr>
<tr>
<td>QBF_Close</td>
<td>Closes a bus.</td>
</tr>
</tbody>
</table>

Point

- Open or close a bus (QBF_Open/QBF_Close functions) once at the start of a program and at the end of a program, respectively.
- By using these functions only once, communication performance will be improved.

2. **I/O access**

   1-point access and 1-word access are available.

   1) **1-point access**: A function that treats 1-point data (ON/OFF of switches and lamps)

      **Example of 1-point access functions**

      | Name        | Function                                           |
      |-------------|----------------------------------------------------|
      | QBF_X_In_BitEx | Reads an input signal (X) in units of one point. |
      | QBF_Y_Out_BitEx | Outputs an output signal (Y) in units of one point. |
      | QBF_Y_In_Bit_Ex   | Reads an output signal (Y) in units of one point. |

   2) **1-word access**: A function that treats 1-word (16 bits) data (numeric values, characters)

      **Example of 1-word access functions**

      | Name         | Function                                         |
      |--------------|--------------------------------------------------|
      | QBF_X_In_WordEx | Reads an input signal (X) in units of words.   |
      | QBF_Y_Out_WordEx | Outputs an output signal (Y) in units of words. |
      | QBF_Y_In_WordEx   | Reads an output signal (Y) in units of words.  |
2. C Controller Module Dedicated Function

(1) User LED control

Indicator LED control and the dot matrix LED control are available.

Example of user LED control functions

<table>
<thead>
<tr>
<th>Name</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>CCPU_SetLEDStatus</td>
<td>Controls Indicator LED of a C Controller module.</td>
</tr>
<tr>
<td>CCPU_SetDotMatrixLED</td>
<td>Controls the dot matrix LED of a C Controller module.</td>
</tr>
</tbody>
</table>

Reference

Only the basic bus interface functions are explained in this section. The MELSEC communication function used for reading/writing of devices via a network are also available. For details of the dedicated function library, refer to the following.

[Setting/monitoring tools for the C Controller module → [Help] → [Function help] → [C Controller module function help]]

2) Dedicated functions used in this guide

Dedicated functions of output access and the dot matrix LED control, are used in the program created in this guide.

- Opening a bus: QBF_Open functions

<table>
<thead>
<tr>
<th>Type</th>
<th>Argument</th>
<th>Name</th>
<th>Function</th>
<th>IN/OUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>short</td>
<td>sUnit</td>
<td>Module identification</td>
<td>Specify the module. (2: C controller module)</td>
<td>IN</td>
</tr>
<tr>
<td>long*</td>
<td>plPath</td>
<td>Path of bus</td>
<td>Stores the pointer to the path of the opened module.</td>
<td>OUT</td>
</tr>
</tbody>
</table>

- Closing a bus: QBF_Close functions

<table>
<thead>
<tr>
<th>Type</th>
<th>Argument</th>
<th>Name</th>
<th>Function</th>
<th>IN/OUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>long</td>
<td>lPath</td>
<td>Path of bus</td>
<td>Specifies the path of the opened bus.</td>
<td>IN</td>
</tr>
</tbody>
</table>
• Output access: QBF_Y_Out_WordEx function

<table>
<thead>
<tr>
<th>Type</th>
<th>Argument</th>
<th>Name</th>
<th>Function</th>
<th>IN/OUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>long</td>
<td>lPath</td>
<td>Path of bus</td>
<td>Specifies the path of the opened bus.</td>
<td>IN</td>
</tr>
<tr>
<td>short</td>
<td>sFlg</td>
<td>Access flag</td>
<td>Specifies an access flag.</td>
<td>IN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(0: Normal access, other than 0: Reserved)</td>
<td></td>
</tr>
<tr>
<td>unsigned short</td>
<td>usYNo</td>
<td>Start output number</td>
<td>Specifies a start output number (Y). (Specify a multiple of 16.)</td>
<td>IN</td>
</tr>
<tr>
<td>unsigned short</td>
<td>usSize</td>
<td>Output size</td>
<td>Specifies the output data size in 1-word units.</td>
<td>IN</td>
</tr>
<tr>
<td>unsigned short*</td>
<td>pusDataBuf</td>
<td>Data storage destination</td>
<td>Specifies the storage destination of output data.</td>
<td>IN</td>
</tr>
<tr>
<td>unsigned short</td>
<td>usBufSize</td>
<td>Size of data storage destination</td>
<td>Specifies 0. (dummy)</td>
<td>IN</td>
</tr>
</tbody>
</table>

• Dot matrix LED control: CCPU_SetDotMatrix LED function

<table>
<thead>
<tr>
<th>Type</th>
<th>Argument</th>
<th>Name</th>
<th>Function</th>
<th>IN/OUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>unsigned short</td>
<td>usLedMode</td>
<td>Output mode</td>
<td>Specifies the output mode for the dot matrix LED.</td>
<td>IN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>When Reserved is specified, this function completes normally without processing.</td>
<td>IN</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(0: Dot mode, 1: ASCII mode, Others: Reserved)</td>
<td></td>
</tr>
<tr>
<td>char*</td>
<td>pcData</td>
<td>LED data</td>
<td>Specifies the LED data.</td>
<td>IN</td>
</tr>
</tbody>
</table>

Reference

The following data types are available for C language and C++ language programming used on a C Controller module.

<table>
<thead>
<tr>
<th>Data type</th>
<th>Bit width</th>
<th>Designation</th>
</tr>
</thead>
<tbody>
<tr>
<td>byte</td>
<td>8</td>
<td>Unsigned integer</td>
</tr>
<tr>
<td>char</td>
<td>8</td>
<td>Character string</td>
</tr>
<tr>
<td>unsigned char</td>
<td>8</td>
<td>Unsigned character string</td>
</tr>
<tr>
<td>short</td>
<td>16</td>
<td>Signed short integer</td>
</tr>
<tr>
<td>unsigned short</td>
<td>16</td>
<td>Unsigned short integer</td>
</tr>
<tr>
<td>int</td>
<td>32</td>
<td>Signed (long) integer</td>
</tr>
<tr>
<td>long</td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>unsigned long</td>
<td>32</td>
<td>Unsigned (long) integer</td>
</tr>
<tr>
<td>float</td>
<td>32</td>
<td>Single-precision real number</td>
</tr>
<tr>
<td>double</td>
<td>64</td>
<td>Double-precision real number</td>
</tr>
<tr>
<td>void</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
<5> Programming

Create a program in which lamps connected to an output module and the dot matrix LED on the front of the C Controller module flash.

I. Program example and control description

Create a program that performs the following control.

When the C Controller module is set to RUN, output lamps Y00 and Y01 alternately turn on. Synchronizing with the on status of the output lamps, the tens place and ones place of the dot matrix LED alternately turn on.

```c
/* Perform an output control and dot matrix LED control in turns by 20 times. */
for(i = 0; i < 20; i++) {
    /* Output control */
    sRet = QBF_Y_Out_WordEx(lPath, NORMAL_ACCESS, UNIT_XY, WORD, &usDataBuf, DUMMY);
    if(sRet != 0) {
        printf("ERROR : QBF_Y_Out_WordEx_1 [%d(%04hxH)]\n", sRet, sRet);
        QBF_Close(lPath);
        return;
    }
    /* dot matrix LED control */
    sRet = CCPU_SetDotMatrixLED(MODE_ASCII, &pcdata[0]);
    if(sRet != 0) {
        printf("ERROR : CCPU_SetDotMatrixLED_1 [%d(%04hxH)]\n", sRet, sRet);
        QBF_Close(lPath);
        return;
    }
}
```

2. Source code

The following describes source codes.

```c
/* Function header */
/*---------------------------------------------------------------*/
#include <vworks.h>  /* VxWorks function header */
#include <taskLib.h> /* VxWorks function header */
#include <stdio.h>  /* Standard function header */
#include "QBFunc.h"  /* Bus interface function header */
#include "CControllerFunc.h"  /* C Controller module dedicated function header */

/* Definition */
/*---------------------------------------------------------------*/

/* For debugging */
#define UNIT_XY   0x0020 /* Start I/O number of the module */
#define QY_LED    0x5555 /* Initial output value of Y signal (even bit: 0 on) */
#define LED_1_2   0x38  /* Initial output value of dot matrix LED (LED1,2) */
#define LED_3_4   0x20  /* Initial output value of dot matrix LED (LED3,4) */

/* For QB function */
#define CPU_TYPE   2  /* CPU identification flag (CCPU: 2) */
#define WORD       1  /* Word specification */
#define NORMAL_ACCESS   0  /* General access specification */
#define DUMMY       0  /* Dummy */
#define MODE.ASCII  1  /* Dot matrix LED control mode */

/* Process outputs from Y signal and control the dot matrix LED */
void Q24_SampleTask()
{
  /* Declare local variables */
  short sRet; /* Return value of the QB function */
  long iPPath; /* Path of a bus */
  unsigned short usDataBase; /* Signal in units of words */
  unsigned short usEmptyDataBuf; /* For reset of Y signal */
  char pdata[4]; /* Dot matrix LED on value */
  short i; /* For loop */

  /* Open the bus */
  sRet = QBF_Open(CPU_TYPE, &iPPath);
  if(sRet != 0){
    printf("ERROR : QBF_Open [%d(%04hxh)]\n", sRet, iPPath);
    return;
  }

  /* Set the output signal (Y) value (turn on the even bit) */
  usDataBase = QY_LED;

  /* Set the output value of the dot matrix LED (LED1,2 on) */
  pdata[0] = LED_1_2;
  pdata[1] = LED_1_2;
  pdata[2] = LED_3_4;
  pdata[3] = LED_3_4;

  /* Perform an output control and dot matrix LED control in turns by 20 times. */
  for(i = 0; i < 20; i++){
    /* Output control */
    sRet = QBF_Y_Out_WordEx(iPPath, NORMAL_ACCESS, UNIT_XY, WORD, &usDataBase, DUMMY);
    if(sRet != 0){
      printf("ERROR : QBF_Y_Out_WordEx [%d(%04hxh)]\n", sRet, iPPath);
      QBF_Close(iPPath);
      return;
    }

    /* Dot matrix LED control */
    sRet = CControllerSetDotMatrixLED(MODE_ASCII, &pdata[0]);
    if(sRet != 0){
      printf("ERROR : CControllerSetDotMatrixLED [%d(%04hxh)]\n", sRet, iPPath);
      QBF_Close(iPPath);
      return;
    }
  }

  /* Invert the output signal (Y) value (turn on the bits in order of odd bit -> even bit ->...). */
  usDataBase = ~usDataBase;
```

Declare the file that defined a function list for use of the library function.

Define values used for the control.

Enable the bus interface function at the start of the program.

Control the output module using the bus interface function.

Control the dot matrix LED using the bus interface function.
/* Switch the output of the dot matrix LED(LED1,2: on -> LED3,4: on). */
if(i % 2 == 0){
    pcdaten[0] = LED_SPACE;
    pcdaten[1] = LED_SPACE;
    pcdaten[2] = LED_8;
    pcdaten[3] = LED_8;
} else{
    pcdaten[0] = LED_8;
    pcdaten[1] = LED_8;
    pcdaten[2] = LED_SPACE;
    pcdaten[3] = LED_SPACE;
}

/* Wait. */
taskDelay(40);

/* Reset the Y signal. */
usEmptyDataBuf = 0x00;
sRet = QBF_Y_Out_WordEx(Path, NORMAL_ACCESS, UNIT_XY, WORD,
                         &usEmptyDataBuf, DUMMY);
if(sRet != 0)
    printf("ERROR: QBF_Y_Out_WordEx_2 [\%d(\%04hxH)]\n", sRet, sRet);
    QBF_Close(Path);
    return;

/* Reset the dot matrix LED. */
    pcdaten[0] = LED_SPACE;
    pcdaten[1] = LED_SPACE;
    pcdaten[2] = LED_SPACE;
    pcdaten[3] = LED_SPACE;
    sRet = CPU_SetDotMatrixLED(MODE_ASCII, &pcdaten[0]);
    if(sRet != 0)
        printf("ERROR: CPU_SetDotMatrixLED_2 [\%d(\%04hxH)]\n", sRet, sRet);
        QBF_Close(Path);
        return;

/* Close the bus. */
    QBF_Close(Path);
    return;

Turn off both outputs from the output module and the dot matrix LED.

Disable the bus interface function at the end of the program.
1) Creating a project

I. Starting CW Workbench

Operating procedure

1) Select [start]→[All Programs]→[Wind River]→[CW Workbench].

2) Enter the storage location of the workspace. In this procedure, enter "C:\WindRiver\workspace".

3) Click the **OK** button.

4) Click the **Close** button.

The main window of CW Workbench appears.

• The default window sizes and icon positions on CW Workbench depends on a personal computer. If a window size differs from that shown in this guide, adjust the size.
• To default an enlarged/deleted window, select [Window]→[New Window].
2. Creating a project

Operating procedure:

1) Select [File] → [New] → [Wind River Workbench Project...].

2) Select "Wind River VxWorks6.8".

3) Click the \( \text{Next} \) button.

4) Select "Downloadable Kernel Module".

5) Click the \( \text{Next} \) button.

6) Enter a project name. In this procedure, enter "Q24_SampleProject".

7) Click the \( \text{Finish} \) button.

The project has been created.
3. Creating a project property
Configure settings to convert (build) the created project into a module that can be executed on a C Controller module.

**Terminology**
Build: An operation that compiles source codes according to a processor and links the code to the include file.

(1) Setting the processor
1) Select the created project in the "Project Explorer" window, and click [Project] → [Properties].

2) Select "Build Properties" from the tree view to the left in the window.
3) Click the "Build Support and Specs" tab.
4) Select the "PENTIUM4gnu" check box only in "Available and enabled build specs:"
5) Select the "Debug mode" check box.

(2) Setting a include file
1) Click the "Build Paths" tab.
2) Click the button.

3) Click the button.

Clear the "Debug mode" check box for the actual system operation.
4) Select the include folder dedicated for the C Controller module in the "Select directory" window.
   In this procedure, the folder is the one when Setting/monitoring tools for the C Controller module has been installed on "C:\MESEC".

5) Click the **OK** button.

6) Check that the folder specified in the "Add include search path to selected build spec" window has been selected.

7) Click the **OK** button.

8) Check that the added include path is displayed in the "Include paths:" area.

9) Click the **OK** button.

10) If the following message appears after clicking the **OK** button, click the **Yes** button.

The project property has been set.
2) Creating a user program

Create a user program that controls a C Controller system.

Operating procedure

1) Right-click the created project in the “Project Explorer” window, and click [New]→[File].

2) Enter a source file name to be created in “File name:”. Enter "Q24_Sample.c" in this procedure.

Point

Enter a file name with extension. Do not use two-byte characters for a file name. If used, a compilation error occurs in compilation.

3) Click the [Finish] button.

4) Describe "Source code"(P.30) to access the output module and to control the dot matrix LED in the “Editor” window.
3) Generating an execution module from the user program

Convert (Build) the created program into a module that can be executed on a C Controller module.

Operating procedure

1) Right-click the created project in the "Project Explorer" window, and click [Rebuild Project].

2) If the message shown below appears, click the "Continue" button.

   The project starts to be built. The progress is displayed in the "Build Console" window.

3) Check that "Build Finished..." is displayed in the "Build Console" window.

"Build Finished..." indicates the completion of creation and build of the user program.

Point

If "Build Finished..." is not displayed and an error occurs, check the error and correct the program.
After the correction, perform the operation again from "3) Generating an execution module from the user program" (P.37).
4) Connecting a C Controller module to CW Workbench

Connect the user Ethernet port CH1 of a C Controller module to CW Workbench to perform debugging using CW Workbench.

**Operating procedure**

1) To acquire a VxWorks image file from the C Controller module, start Explorer and enter the following address in the address area.
   ftp://192.168.3.3/SYSTEMROM/OS_IMAGEFILE/

   The "Log On As" window appears.

2) Enter the following user name and password in the "Log On As" window.
   - User name : target
   - Password : password

3) Click the Log On button.

4) Copy the VxWorks image file stored on the C Controller module to "C:\MELSEC\CCPU4\CCPUTool".

   The "C:\MELSEC\CCPU4\CCPUTool" folder is created when Setting/monitoring tools for the C Controller module has been installed on "C:\MELSEC".

5) Click in the "Remote Systems" window.

   The "New Connection" window appears.

6) Select "Wind River VxWorks 6.x Target Server Connection" in the "New Connection" window.

7) Click the Next > button.
8) Set the following items in "Backend settings".
   • Backend : wdbrpc
   • Processor : Z5xx (Click the Select... button and select the processor.)
   • IP address : 192.168.3.3 (default)
   • Port : Blank

9) Select the "File" radio button in "Kernel image".

10) Click the Browse button.

12) Click the Finish button.

13) Select the target server added in the "Remote Systems" window, and click Begin.

14) After Begin is clicked, the connection is completed when "connected - target server running" is displayed at the bottom of the "Remote Systems" window.

If "connected - target server running" is not displayed, check that the C Controller module is normally powered on, and perform the operation again from "4) Connecting a C Controller module to CW Workbench"(P.38).
5) Debugging the user program

Check that the created program correctly operates.

I. Downloading the user program on the C Controller module

To debug the user program, download the execution module on the memory in the C Controller module.

Downloading a user program allows users to execute the program without a script file.

### Terminology

**Script file**: A file that describes the download location and the startup procedure of the user program that starts at the start of a C Controller module.

1) Right-click the created module file "Q24_SampleProject.out" in the "Project Explorer" window, and click [Download VxWorks Kernel Task].

The "Download Configurations" window appears.

2) Select the "VxWorks6x_192.168.3.3 (Wind River VxWorks 6.8)" check box only in "Launch Context:.

3) Click the [Download] button.

The "Launch Configuration Selection" window appears on and after the second operation of the step 2). Select the "Launch the selected launch configuration" radio button and click the [OK] button.
2. Debugging the user program

1) Select the created project in the "Project Explorer" window, and click ▼ on the right side of on the toolbar.

2) Click [Debug Configurations...].

The "Debug Configurations" window appears.

3) Click the downloaded module "Q24_SampleProject.out" from "VxWorks Kernel Task".

4) Select the target server indicating connection to the C Controller module.

5) Click the button.

The "Entry Points" window appears.

6) Select the function that starts debugging (Q24_SampleTask).

7) Click the button.

8) Check that the function name selected in the step 6) has been selected in "Entry Point:"

9) Click the button.

10) Debugging starts. Program execution stops at the start of the function specified in "Entry Point:".
11) Click in the "Debug" window to perform debugging by one step.

12) By clicking a tab on the bottom right of the "Variables" window, variable values can be checked and changed. In this step, check that "sRet", return value of the "QBF_Open" function, is "0" (normal value).

*1 Depending on a personal computer, the "Variables" window appears as shown below. Adjust the window size.

In the steps 11) and 12), debug the entire program.

---

If the return value of the bus interface function and C Controller Module dedicated function is other than "0", troubleshoot with reference to the following.

- Setting/monitoring tools for the C Controller module → [Help] → [Function help] → [C Controller module function help]

<Debugging using breakpoint>

As well as debugging in units of one step described in the step 11), debugging using a breakpoint is available.

1) Double-click the left edge of a source file window and insert a breakpoint.

   ![Image of debugging setup]

   1) Double-click the left edge of a source file window and insert a breakpoint.

2) Click .

   ![Image of breakpoint setting]

   2) Click .

   The program is executed at the position specified by the breakpoint.

   ![Image of program execution]

   The program is executed at the position specified by the breakpoint.

The descriptions of icons are as follows:

- : Step Into
  Steps into the called function and stops at the first line of the function.

- : Step Over
  Executes the current line of the function and then stops at the next line of the function.

- : Continue
  Continues execution until the current function has returned to its caller.

- : Execute
  Executes a program.

- : Stop
  Stops a program.

- : End
  Ends debugging.

13) Click in the "Debug" window to terminate the debugging session.

   ![Image of debugging termination]

   13) Click in the "Debug" window to terminate the debugging session.

To start debugging again, click on the right side of on the toolbar and select the created debug configuration at the top of the pop-up menu.

The steps 1) to 10) can be skipped.
6) Registering an execution module

Build the created program for operation and store the created module on the C Controller module.

Operating procedure:

I. Building the user program

1) Select the created project in the "Project Explorer" window, and click [Project]→[Properties].

2) Select "Build Properties" from the tree view to the left in the window.

3) Clear the "Debug mode" check box.

4) Click the OK button.

5) Build the program following the procedure shown in "3) Generating an execution module from the user program"(P.37).

6) If the following message appears, click the Yes button.

II. Storing the user program

1) Start Explorer and enter the following address in the address area for the C Controller module.
ftp://192.168.3.3/ROM

After login to the C Controller module, the address is displayed as shown below.

2) Copy the created user program "Q24_SampleProject.out" on the standard ROM for the C Controller module by drag and drop. The user program created in this guide is stored on the following:
C:\WindRiver\workspace\Q24_SampleProject\PE NTIUM4gnu\Q24_SampleProject\NonDebug
3. Creating and storing a script file

Create a script file that automatically downloads the execution module at the start of the C Controller module.

1) Open a text file and describe a script file that downloads the user program and generates the task as shown below.

```
// Load the program.
id(1,0,"/ROM/Q24_SampleProject.out")
// Generates the task.
sp(Q24_SampleTask)
```

The "Q24_SampleTask" function is generated under the default task name (t1).

2) Name the file as "STARTUP.CMD" and save the file.

3) Copy the created script file on the standard ROM of the C Controller module.

ftp://192.168.3.3/ROM

The script file has been created and stored.

---

A user program and a script file can be stored on the SD memory card as well. When a script file is stored both the standard ROM and the SD memory card, one on the SD memory card is started by priority.
<6> Checking Operations

Execute the program registered with the C Controller module and check operations.

Use the “RUN/STOP/MODE” and “RESET/SELECT” switches on the front of the C Controller module.

[Functions of the "RUN/STOP/MODE" switch]
- RUN : Enables outputs (Y) and writing to the buffer memory from a user program
- STOP : Disables outputs (Y) and writing to the buffer memory from a user program
- MODE : Used for the hardware self-diagnostic function

[Functions of the "RESET/SELECT" switch]
- RESET : Resets hardware and programs.
- SELECT : Used for the hardware self-diagnostic function

Point

The C Controller module executes program operation regardless of the switch status (RUN/STOP).

Reference

For details on the "RUN/STOP/MODE" and "RESET/SELECT" switches, refer to the following.

**Operating procedure**

1. Enable outputs (Y) from the user program.

   - Set the "RUN/STOP/MODE" switch on the front of the C Controller module to "RUN".
   - When the "RUN" LED lights in green, the program is running normally.

   **Point**

   To disable outputs (Y) from the user program, set the "RUN/STOP/MODE" switch to "STOP".

2. Reset the C Controller module.

   - Set the "RESET/SELECT" switch on the front of the C Controller module to "RESET".
   - Check that the "MODE" LED turns off. [Reset completed]
   - Set the "RESET/SELECT" switch to the center.

**Reference**

If the "ERR." LED turns on or starts flashing, troubleshoot with reference to the following.

* MELSEC-Q C Controller Module User's Manual: SH-081130ENG*
3. Use the dot matrix LED and lamps to check operations.
   The dot matrix LED on the front of the C Controller module and output lamps operate as follows:
   1) The tens place and ones place of the dot matrix LED alternately turn on by 20 times.
   2) Synchronizing with the dot matrix LED, output lamps Y20 and Y21 alternately turn on.

3) To check the operations again, reset the C Controller module.

Reference

Status of the dot matrix LED and the output lamps also can be checked on Setting/monitoring tools for the C Controller module. ((P.49), (P.52))
FREQUENTLY-USED FUNCTIONS

This chapter describes functions frequently used for the start-up and the maintenance after operation of a C Controller system.

<1> Checking Errors

An error can be checked and the corrective action can be taken using Setting/monitoring tools for the C Controller module.

1) How to check an error

1) Select [Diagnostics] → [CCPU diagnostics] in Setting/monitoring tools for the C Controller module.

2) The C Controller module diagnostic screen appears

3) An error code is displayed in the window.

4) The check boxes of the current errors color in red ( ).

The error code is kept updated during monitoring.
2) Checking error history

Errors occurred up to the present and the error details can be checked. When and what kind of error occurs can be checked, useful in error analysis.

1) Start up Setting/monitoring tools for the C Controller module.

2) Select [Diagnostics]→[Event history].

3) Error history and the error details are displayed.

4) To see more details of an error, double-click the error.

5) Clicking the or the button will display the details of the previous or the following error.

6) Clicking the button will open the help window on the error.
Module I/O status and buffer memory status can be checked through Setting/monitoring tools for the C Controller module. I/O status can be checked and operations can be tested at start-up and maintenance.

1) Checking module I/O status and buffer memory status

The input (X) and output (Y) status of the module and buffer memory status can be monitored.

**Terminology**

Buffer memory: The memory of an intelligent function module (module such as A/D conversion module and D/A conversion module having a function other than input and output) used to store data (such as setting values and monitored values) for communication with a C Controller module.

**Operating procedure**

1. Select [Online] → [Device monitor] of Setting/monitoring tools for the C Controller module.

The "Device monitoring" window appears.
2. Check the "Device monitoring" window.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1)</td>
<td>Device</td>
<td>Enter the device name.</td>
</tr>
<tr>
<td>2)</td>
<td>Monitor format</td>
<td>Set the monitor format. Bit &amp; Word: Set the monitor screen to the bit and word display. Bit: Set the monitor screen to the bit display only. Word: Set the monitor screen to the word display only.</td>
</tr>
<tr>
<td>3)</td>
<td>Display</td>
<td>Set the display format of the device values to be displayed when the monitor format is &quot;Bit &amp; Word&quot; or &quot;Word&quot;.</td>
</tr>
<tr>
<td>4)</td>
<td>Data format</td>
<td>Set the radix (decimal/hexadecimal) when the display format is &quot;16 bit integer&quot; or &quot;32 bit integer&quot;.</td>
</tr>
<tr>
<td>5)</td>
<td>Bit order</td>
<td>Set the order in which the bit devices being monitored are arranged. F-0: Arranged in order of F, E, ... 1, 0 from left to right. 0-F: Arranged in order of 0, 1, ... E, F from left to right.</td>
</tr>
</tbody>
</table>
2) Testing operations by forced output

Module operations can be tested by forced output from an output (Y).
The following describes the procedure for forced output.

1. Click the **Force ON** button in the "Write to Device" screen.

![Write to Device screen]

2. Forced output from an output (Y) is executed.

Extra:

An operation test by forced write to a buffer memory can be executed in the same manner.
Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Ethernet is a registered trademark of Fuji Xerox Co., Ltd. in Japan.

The SD and SDHC logos are trademarks of SD-3C, LLC.

VxWorks is either registered trademarks or trademarks of WindRiver Systems, Inc.

The company names, system names and product names mentioned in this manual are either registered trademarks or trademarks of their respective companies.

In some cases, trademark symbols such as "™" or "®" are not specified in this manual.

Precautions before use

This publication explains the typical features and functions of the products herein and does not provide restrictions and other information related to usage and module combinations. Before using the products, always read the product user manuals. Mitsubishi Electric will not be held liable for damage caused by factors found not to be the cause of Mitsubishi Electric; opportunity loss or lost profits caused by faults in Mitsubishi Electric products; damage, secondary damage, or accident compensation, whether foreseeable or not, caused by special factors; damage to products other than Mitsubishi Electric products; and to other duties.

For safe use

- To use the products given in this publication properly, always read the relevant manuals before use.
- The products have been manufactured as general-purpose parts for general industries, and have not been designed or manufactured to be incorporated in a device or system used in purposes related to human life.
- Before using the products for special purposes such as nuclear power, electric power, aerospace, medicine or passenger movement vehicles, consult with Mitsubishi.
- The products have been manufactured under strict quality control. However, when installing the products where major accidents or losses could occur if the products fail, install appropriate backup or fail-safe functions in the system.
# C Controller Quick Start Guide

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Sales office</th>
<th>Tel/Fax</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA</td>
<td>MITSUBISHI ELECTRIC AUTOMATION, INC.</td>
<td>+1-847-478-2100</td>
</tr>
<tr>
<td></td>
<td>500 Corporate Woods Parkway, Vernon Hills, IL 60061, U.S.A.</td>
<td>+1-847-478-2253</td>
</tr>
<tr>
<td>Mexico</td>
<td>MITSUBISHI ELECTRIC AUTOMATION, INC. Mexico Branch</td>
<td>+52-55-3067-7500</td>
</tr>
<tr>
<td></td>
<td>Mariano Escobedo #69, Col. Zona Industrial, Tlalnepantla Edo. Mexico, C.P.54030</td>
<td></td>
</tr>
<tr>
<td>Brazil</td>
<td>MITSUBISHI ELECTRIC DO BRASIL COMÉRCIO E SERVIÇOS LTDA.</td>
<td>+55-11-6489-3000</td>
</tr>
<tr>
<td></td>
<td>Avenida Adelino Cardana, 293, 21 andar, Belaville, Barueri SP, Brazil</td>
<td>+55-11-6489-3016</td>
</tr>
<tr>
<td>Germany</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. German Branch</td>
<td>+49-2102-486-0</td>
</tr>
<tr>
<td></td>
<td>Mitsuishi-Electric-Platz 1, 40887 Ratingen, Germany</td>
<td>+49-2102-486-1130</td>
</tr>
<tr>
<td>UK</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. UK Branch</td>
<td>+44-1707-28-8780</td>
</tr>
<tr>
<td></td>
<td>Travellers Lane, Hafthiel, Hertfordshire, AL10 8XJ, U.K.</td>
<td>+44-1707-27-8695</td>
</tr>
<tr>
<td>Ireland</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. Irish Branch</td>
<td>+353-1-4198800</td>
</tr>
<tr>
<td></td>
<td>Westgate Business Park, Ballymount, Dublin 24, Ireland</td>
<td>+353-1-4198890</td>
</tr>
<tr>
<td>Italy</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. Italian Branch</td>
<td>+39-039-60531</td>
</tr>
<tr>
<td></td>
<td>Centro Direzionale Colleoni/Palazzo Sirio Viale Colleoni 7, 20864 Agrate Brianza(Milano) Italy</td>
<td>+39-039-6053-312</td>
</tr>
<tr>
<td>Spain</td>
<td>MITSUBISHI ELECTRIC EUROPE, B.V. Spanish Branch</td>
<td>+34-935-65-3131</td>
</tr>
<tr>
<td></td>
<td>Carretera de Rubí, 76-80-Apdo. 420, 08310 Sant Cugat del Vallés (Barcelona), Spain</td>
<td>+34-935-69-1579</td>
</tr>
<tr>
<td>France</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. French Branch</td>
<td>+33-1-55-68-55-68</td>
</tr>
<tr>
<td></td>
<td>25, Boulevard des Bouvets, 92741 Nanterre Cedex, France</td>
<td>+33-1-55-68-57-57</td>
</tr>
<tr>
<td>Czech Republic</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. Czech Branch</td>
<td>+420-251-551-470</td>
</tr>
<tr>
<td></td>
<td>Avenir Business Park, Radlicka 7511/3e, 158 00 Praha5, Czech Republic</td>
<td>+420-251-551-471</td>
</tr>
<tr>
<td>Poland</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. Polish Branch</td>
<td>+48-12-347-65-00</td>
</tr>
<tr>
<td></td>
<td>ul. Krakowska 50, 32-083 Balice, Poland</td>
<td>+48-12-630-47-01</td>
</tr>
<tr>
<td>Sweden</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. (Scandinavia)</td>
<td>+46-8-625-10-00</td>
</tr>
<tr>
<td></td>
<td>Fielevägen 8, SE-22736 Lund, Sweden</td>
<td>+46-46-39-70-18</td>
</tr>
<tr>
<td>Russia</td>
<td>MITSUBISHI ELECTRIC (RUSSIA) LLC St. Petersburg Branch</td>
<td>+7-812-633-3497</td>
</tr>
<tr>
<td></td>
<td>Piskarevskiy pr. 2, bd2, lit &quot;Sch&quot;, BC &quot;Benua&quot;, office 720, 190527 St. Petersburg, Russia</td>
<td>+7-812-633-3499</td>
</tr>
<tr>
<td>Turkey</td>
<td>MITSUBISHI ELECTRIC TURKEY A.Ş Ümraniye Branch</td>
<td>+90-216-686-2500</td>
</tr>
<tr>
<td></td>
<td>Serifli Mah. Kale Sok, No:41 34775 Ümraniye - Istanbul, Turkey</td>
<td>+90-216-526-3996</td>
</tr>
<tr>
<td>UAE</td>
<td>MITSUBISHI ELECTRIC EUROPE B.V. Dubai Branch</td>
<td>+971-4-3724716</td>
</tr>
<tr>
<td></td>
<td>Dubai Silicon Oasis, P.O.BOX 341241, Dubai, U.A.E.</td>
<td>+971-4-3724721</td>
</tr>
<tr>
<td>South Africa</td>
<td>ADROIT TECHNOLOGIES</td>
<td>+27-11-658-8100</td>
</tr>
<tr>
<td></td>
<td>20 Waterford Office Park, 189 Witkoppen Road, Fourways, South Africa</td>
<td>+27-11-658-8101</td>
</tr>
<tr>
<td>China</td>
<td>MITSUBISHI ELECTRIC AUTOMATION (CHINA) LTD.</td>
<td>+86-21-2322-3000</td>
</tr>
<tr>
<td></td>
<td>No.1386 Hengqiao Road, Mitsuishi Electric Automation Center, Shanghai, China</td>
<td>+86-21-2322-3000</td>
</tr>
<tr>
<td>Taiwan</td>
<td>SETSUYO ENTERPRISE CO., LTD.</td>
<td>+886-2-2299-3499</td>
</tr>
<tr>
<td></td>
<td>6F, No.105, Wupong 3rd Road, Wupu District, New Taipei City 24889, Taiwan</td>
<td>+886-2-2299-2509</td>
</tr>
<tr>
<td>Korea</td>
<td>MITSUBISHI ELECTRIC AUTOMATION KOREA CO., LTD.</td>
<td>+82-2-3680-9530</td>
</tr>
<tr>
<td></td>
<td>7F-9F, Gangseo Hangang Xi-tower A, 401, Gangnam-gu, Seoul 07528, Korea</td>
<td>+82-2-3664-8372</td>
</tr>
<tr>
<td>Singapore</td>
<td>MITSUBISHI ELECTRIC ASIA PTE. LTD.</td>
<td>+65-6473-2303</td>
</tr>
<tr>
<td></td>
<td>307, Alexandra Road, Mitsubishi Electric Building, Singapore 159943</td>
<td>+65-6476-7439</td>
</tr>
<tr>
<td>Thailand</td>
<td>MITSUBISHI ELECTRIC FACTORY AUTOMATION (THAILAND) CO., LTD.</td>
<td>+66-2262-6522</td>
</tr>
<tr>
<td></td>
<td>19th Floor, SV City Building, Office Tower 1, No. 386/19 and 20 Rama 3 Road, Kwaeng Bangpangpong, Khet Yannawa, Bangkok 10120, Thailand</td>
<td>+66-2262-6520</td>
</tr>
<tr>
<td>Vietnam</td>
<td>MITSUBISHI ELECTRIC VIETNAM COMPANY LIMITED Hanoi Branch</td>
<td>+84-4-3937-8075</td>
</tr>
<tr>
<td></td>
<td>6th Floor, Detech Tower, 8 Ton That Thiuet Street, My Dinh 2 Ward, Nam Tu Lien District, Hanoi, Vietnam</td>
<td>+84-4-3937-8076</td>
</tr>
<tr>
<td>Malaysia</td>
<td>MITSUBISHI ELECTRIC SALES MALAYSIA SDN. BHD.</td>
<td>+60-3-7256-5000</td>
</tr>
<tr>
<td></td>
<td>Lot 11, Jalan 21B, 45610 Petaling Jaya, Selangor Darul Ehsan, Malaysia</td>
<td>+60-3-7256-3544</td>
</tr>
<tr>
<td>Indonesia</td>
<td>PT. MITSUBISHI ELECTRIC INDONESIA</td>
<td>+62-21-3192-8461</td>
</tr>
<tr>
<td></td>
<td>Gedung Jaya 11th Floor, Jl. MH. Thamrin No.12, Jakarta Pusat 10340, Indonesia</td>
<td>+62-21-3192-3942</td>
</tr>
<tr>
<td>India</td>
<td>MITSUBISHI ELECTRIC INDIA PVT. LTD. Pune Branch</td>
<td>+91-20-2710-2000</td>
</tr>
<tr>
<td></td>
<td>Emerald House, EL-3, J Block, M.I.D.C., Shosari, Pune-411026, Maharashtra, India</td>
<td>+91-20-2710-2100</td>
</tr>
<tr>
<td>Australia</td>
<td>MITSUBISHI ELECTRIC AUSTRALIA PTY. LTD.</td>
<td>+61-2-9684-7777</td>
</tr>
<tr>
<td></td>
<td>348 Victoria Road, P.O. Box 11, Rydalmere, N.S.W 2116, Australia</td>
<td>+61-2-9684-7245</td>
</tr>
</tbody>
</table>